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License and Copyright Information 
 
 
The software described in this guide is furnished under a written agreement and may be used only in 
accordance with the terms and conditions of the license agreement under which you obtained it.  The 
technical documentation is being delivered to you AS IS and Invensys Systems, Inc. makes no warranty 
as to its accuracy or use.  Any use of the technical documentation or the information contained therein is 
at the risk of the user.  Documentation may include technical or other inaccuracies or typographical 
errors.  Invensys Systems, Inc. reserves the right to make changes without prior notice. 
 
Copyright Notice © 2007 Invensys Systems, Inc.  All rights reserved.  No part of the material protected 
by this copyright may be reproduced or utilized in any form or by any means, electronic or mechanical, 
including photocopying, recording, broadcasting, or by any information storage and retrieval system, 
without permission in writing from Invensys Systems, Inc. 
 
Trademarks PRO/II and Invensys SIMSCI-ESSCOR are trademarks of Invensys plc, its subsidiaries and 
affiliates. 
 
Windows 98, Windows ME, Windows NT, Windows 2000, Window 2003, Windows XP and MS-DOS are 
trademarks of Microsoft Corporation. 
 
All other products may be trademarks of their respective companies. 
 
 
U.S. GOVERNMENT RESTRICTED RIGHTS LEGEND 
 
The Software and accompanying written materials are provided with restricted rights.  Use, duplication, or 
disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the 
Rights in Technical Data And Computer Software clause at DFARS 252.227-7013 or in subparagraphs 
(c) (1) and (2) of the Commercial Computer Software-Restricted Rights clause at 48 C.F.R. 52.227-19, as 
applicable.  The Contractor/Manufacturer is:  Invensys Systems, Inc. (Invensys SIMSCI-ESSCOR) 26561 
Rancho Parkway South, Suite 100, Lake Forest, CA 92630, USA. 
 
Printed in the United States of America, September 2007. 
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What is Simulation? 
Simulation software has had an enormous impact on the petroleum, petrochemical, and chemical process 
industries over the past several decades. Process simulation is almost universally used to guide the design 
of new processes, evaluates alternate plant configurations, troubleshoots and debottlenecks plant process, 
etc. Process simulation programs perform rigorous mass and energy balances for a wide range of 
chemical processes. Other process engineering tools have been developed for heat transfer simulation, 
plant gross error detection, piping network simulation, safety system modeling, etc. 

Dynamic simulation software has also been developed to model plant control systems for detailed 
engineering studies and operator training. Simulations are based on rigorous first-principle models and the 
actual plant controls can be used to troubleshoot process and control problems that occur in the actual 
plant and perform what-if and debottlenecking studies. High fidelity plant simulators are used to train 
operators in a non-destructive environment. 

On-line optimization has been practiced in the hydrocarbon processing industry for over 40 years. On-line 
optimization answers the question of how should a given unit, or groups of units, can be operated to 
maximize economic given constraints of the operating and economic environment. Optimizations are 
typically based on a mathematical model ranging from a unit to a complete manufacturing complex based 
on observed plant performance to rigorous first principles of heat, mass and momentum balances. Most 
recent implementations of on-line optimization utilize first principles models to take advantage of their 
superior accuracy, rigor, range, and maintainability. 

 

Overview of PRO/II 
PRO/II is the flagship offering in SimSci-Esscor's Process Engineering Suite (PES). This steady-state 
simulator performs rigorous mass and energy balances for a wide range of processes. From oil and 
gas separation to reactive distillation, PRO/II combines the data resources of a large chemical 
component library and extensive thermodynamic property prediction methods with the most 
advanced and flexible unit operations techniques. Process engineers benefit from computational 
facilities to perform all mass and energy balance calculations needed to model most steady-state 
processes within the chemical, petroleum, natural gas, solids processing, and polymer industries. 
PRO/II runs in an interactive Windows®-based GUI environment. 
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Simulation Made Easy 
This manual has been developed to help university students learn how to set up simulations, run 
them, and analyze the results. When setting up a simulation, you can supply data in a number of 
ways. The color codes in PRO/II alert you when data is required, marking the pathway towards a 
completed simulation. 

 
When using PRO/II to develop a simulation, we recommend following these steps: 

 
 

 
 
 
 
 
 
 
 
 

    1.)  Build the PFD 
 
Draw the process flow diagram (PFD) by selecting the desired unit operation from the PFD palette 
and dragging-and-dropping that unit on to the flowsheet. Next, draw the feed and product streams 
for each unit by clicking on the streams button on the PFD palette and drawing a stream by clicking 
at the desired starting point and then clicking at the at desired termination point. Often a product 
stream from one unit is the feed stream to another unit. Entering such streams connects the 
flowsheet together and establishes the transfer of information within the simulation. 

          
     2.)  Check the Inputs of Measure 
 

Almost every quantity has a unit of measure. Initially the global default for units of measure set is 
English. You can change this set for this simulation only, or change the global default for all 
simulations. The UOM may also locally override individual dimensional units in data entry windows. 
 
3.)  Define the Components 
 
Components can be defined by typing their library component names, by selecting from lists of 
chemicals, or by entering user-defined components, solids with associated particle size distributions, 
and polymer components. There is also an option to generate pseudocomponents from entered 
petroleum stream assay data.  

 
 4.)  Select the Thermodynamic Method 
 

Selecting the proper thermodynamic methods is a critically important step in the solution of a 
simulation problem. For most problems, a predefined set of thermodynamic methods for calculating 
K-values, enthalpies, entropies, and densities may be used. PRO/II offers numerous categories of 
method sets. Normally one of the thermodynamic systems in the list of Most Commonly Used 
methods is appropriate.  

  
5.)  Supply Process Stream Data 

 
For feed streams, thermal conditions, flowrates, and compositions must be supplied for all external 
feed streams to the flowsheet. It is usually desirable, although not necessary, to provide estimated 
data for recycle streams to speed convergence of recycle calculations. 
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 6.)  Supply Process Unit Data 
 

Supply process data for each unit in the flowsheet. Unit operation identifiers for which data entries 
are needed are marked with red borders. To enter information for a unit operation, double-click its 
icon to open the Unit data entry window.  

 
 7.)  Run the Simulation and View the Results   
 

Before trying to execute the simulation, check that there are no red-bordered fields or red linked text. 
If all the borders are blue, green, or black on the toolbar buttons, unit operation labels, and stream 
labels then enough information has been supplied to run the flowsheet. 
The main portion of the output with all details is contained in the output (*.OUT) file. You can view 
your results in a variety of ways ranging from plots and tables to pop-up windows with values for 
each stream and unit to custom reports generated in Microsoft® Excel. 
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Building the Process Flow Diagram 
The first step in any simulation, no matter how small or large, is to draw the process flow diagram. 
While there is a close correspondence between an actual flowsheet and its simulation flowsheet, 
there are some notable differences. These are: 

 
• Time dependencies 
• Combined units 

 
 

Time Dependencies 
 
Because PRO/II is a steady state simulator, process equipment that control time dependent 
phenomena are not directly relevant to your simulation. Omit units such as control valves and 
instrumentation. However, consider the instrument settings when you are deciding on the 
specifications to make in your flowsheet. 

Thus: 

 

 

 

 

simplifies to 

 

 

 

 

All the control valves, pressure and temperature indicators have been eliminated. You may also 
eliminate utility systems such as cooling water (as here), steam and refrigerants from the simulation 
if you are only interested in the duties they provide. 
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Setting the Input Units of Measure 
Almost every item of data you will enter in PRO/II will have Units of Measure. For simplicity, the Units 
of Measure in PRO/II have been arranged into three standard pre-defined Sets: English, Metric and 
SI. You select the set that nearest matches the needs of your simulation and then over-ride the pre-
defined units for individual quantities. For example, you may select the Metric Set and override the 
Celsius temperature unit with Kelvin. 
 
You can set the units of measure on a global, simulation, and/or field level. 
 
The easiest and most efficient way to enter data involves setting the input units of measure for the 
active single simulation, and then proceed to change the units of measure for a specific field of a 
unit dialog box, if necessary. 
 
To change the default units of measure set for a simulation, click the Units of Measure button on the 
toolbar to open the Default Units of Measure dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

 
 
 

 To change the default set, click the Initialize from UOM Library button, select a set, and click OK. 

 Make any changes to individual units, as desired. 

You can also use this dialog box to override the True vapor pressure temperature basis, the Reid 
vapor pressure calculation method, and standard vapor conditions. 

 UOM Library 
 

You can define and save your own sets by selecting Units of Measure Lists from the Options menu.  
 

Figure 1: Default UOM for Problem Data Input Dialog Box 
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 Global Defaults 

By default, the standard English set is the global default used to start each simulation. You can 
change this global default with your own modified set so that every subsequent simulation starts 
with that set.  

 Select Simulation Defaults / Units of Measure from the Options menu and select your set from 
the list. 

 
 
 

 
Output Units of Measure  

 
Normally, the output report is in the same units as the input Set. However, you may define a different 
set of units for the output.  

 Select Simulation Defaults / Units of Measure from the Options menu and select from the lists.  

If you do want output in a different set of units it is good practice to get it in the input unit set as well, 
so that you can check the correctness of your input data.  

 Select Same as Input for the First Output and your required output set for the Second Output. 

Changing the UOM for a Single Field 

When entering data in a data entry window, you can still enter individual data items in any 
appropriate unit.   

 Place the cursor in the field for the item whose units you want to change. 
 

 Click the UOM button on the toolbar to open the Convert Units of Measure dialog box.   
 

Here you can choose to change the units and retain the value you entered in the field, or to convert 
the value to the new units. 

Figure 2: Default Sets of Units of Measure 
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Notice, however, that the next time you open the data entry window the value will have been 
converted to the set unit of measure. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 3: Convert Units of Measure Dialog Box 
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Defining the Components 
 Library Components 
 

The PRO/II component libraries provide easy automatic access to property data for nearly 2000 pure 
components. When running a simulation, you can retrieve the thermophysical properties for a library 
component from the PRO/II database simply by using an access name or alias. Many components 
have more than one alias. For example, you can retrieve information on methane, using any of the 
following commonly used names:  
 
• C1 
• CH4 
• METH 
• METHANE 
 
PRO/II contains extensive component databanks as well as comprehensive methods for component 
property prediction. In general when PRO/II retrieves component data from one of its libraries, it also 
retrieves the necessary component properties to successfully complete your simulation. If PRO/II 
has incomplete property information for a particular component, you can either “fill in the gaps” with 
established property prediction methods that are based on structural data or input your own 
component property data. 

 
 Click the Component Selection button on the toolbar or select Input/Component Selection from 

the menu bar and select your components using the Component Selection dialog box. 
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If you don't know the exact name or alias of a desired component, you can click the Select from 
Lists... button and search through the available lists. 

 
 

 
 

 
Databanks 
 
The PRO/II component library is actually a composite of several established databanks. 
 
 
Table 1: Pure Component Databanks 

Bank Description 

SIMSCI The SIMSCI pure component databank. 

PROCESS The PROCESS pure component databank. Provides for upward compatibility with 
PROCESS and versions of PRO/II prior to v. 3.01. 

DIPPR The AIChE DIPPR databank, available as an optional PRO/II add-on. 

OLI The OLI databank, available as an optional PRO/II add-on. 

bankid Your own databank, created and maintained using the Property Library Manager. 

 
 
By default, PRO/II searches the SIMSCI databank first and the PROCESS databank second.  
 
 
 

Figure 4: Component Selection Dialog Box 

Figure 5: Component Selection – List/Search Dialog Box 
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Component Properties 
Components in a PRO/II databank have a full range of properties. Component properties fall into six 
categories: 
 
• Fixed properties 
• Temperature-dependent properties 
• User Defined and Refinery Inspection properties 
• Solid properties 
• Polymer properties 
• Structure data 

 
The pure component properties that you need to run a simulation may depend upon the selected 
thermodynamic method. The required properties are listed for each method in the Thermodynamic 
Methods section of the PRO/II Reference Manual.  
 
Following, are a few of the most important data requirements: 
 
• With the exception of components declared to exist only as solids, all components must have a 

molecular weight and a specific gravity (which may be alternatively supplied as an API gravity or 
standard liquid density). 

• For calculations with an equation of state method (such as Soave-Redlich-Kwong or Peng-
Robinson), PRO/II requires the critical temperatures and critical pressures of the components. 
Each component also requires either an acentric factor or a correlation for the equation’s alpha 
parameter. 

• K-value calculations with liquid activity coefficient methods (such as NRTL and UNIQUAC) require 
pure component vapor pressures. Several of these methods also require other properties such as 
liquid molar volumes, solubility parameters, or van der Waals area and volume parameters. 

• All enthalpy and entropy methods require ideal gas enthalpies for each component, with the 
exception of the Ideal and Johnson-Grayson methods. 

• The Ideal method for liquid enthalpy requires the enthalpy of the saturated liquid. Use of this 
method for vapor enthalpies requires saturated liquid enthalpies, plus the latent heat of 
vaporization for each component. Ideal liquid densities require saturated liquid densities. 

 
Again, in most cases, you do not need to worry about such requirements because the components 
retrieved from PRO/II’s databanks will have sufficient data for any thermodynamic method. 
 
Fixed Properties 
 
To display the fixed properties of the selected components in your simulation, click the Component 
Properties button on the toolbar and from the Component Properties dialog box, click the Fixed 
Properties button. Here, you can enter user-defined component properties or replace data for library 
components. Table 2 displays the sub-dialog box in which each property is located. In some dialog 
boxes you have to scroll horizontally to see all the properties.  

Table 2: Location of Fixed Properties 

Property Dialog Box / Sub-Dialog Box 

Acentric Factor Fixed Properties / Miscellaneous Properties 

Carbon Number Fixed Properties / Miscellaneous Properties 

Critical Compressibility Factor Fixed Properties / Critical Properties 

Critical Pressure Fixed Properties / Critical Properties 
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Critical Temperature Fixed Properties / Critical Properties 

Critical Volume Fixed Properties / Critical Properties 

Dipole Moment Fixed Properties / Molecular Constants 

Enthalpy of Combustion Fixed Properties / Miscellaneous Properties 

Enthalpy of Fusion Fixed Properties / Miscellaneous Properties 

Gibbs Energy of Formation Fixed Properties / Heats of Formation 

Freezing Point (Normal Melting Point) Fixed Properties / Miscellaneous Properties 

Gross Heating Value Fixed Properties / Miscellaneous Properties 

Heat of Formation Fixed Properties / Heats of Formation 

Heat of Vaporization Fixed Properties / Miscellaneous Properties 

Hydrogen Deficiency Number  Fixed Properties / Miscellaneous Properties 

Liquid Molar Volume Fixed Properties / Miscellaneous Properties 

Lower Heating Value Fixed Properties / Miscellaneous Properties 

Molecular Weight Fixed Properties 

Normal Boiling Point Fixed Properties 

Rackett Parameter Fixed Properties / Miscellaneous Properties 

Radius of Gyration Fixed Properties / Molecular Constants 

Solubility Parameter Fixed Properties / Miscellaneous Properties 

Specific Gravity Fixed Properties 

Triple Point Pressure Fixed Properties / Miscellaneous Properties 

Triple Point Temperature  Fixed Properties / Miscellaneous Properties 

van der Waals Area and Volume Fixed Properties / Molecular Constants 
 
 
Temperature Dependent Properties 
 
You can enter the temperature-dependent properties given in Table 3 below in either tabular or 
equation form. Extrapolation of temperature-dependent properties outside the user-defined 
temperature limits is performed linearly, except for vapor pressure and viscosity, which are 
extrapolated as ln(property) versus the reciprocal of the absolute temperature. These methods are 
also used for interpolation and extrapolation of tabular property data and for extrapolation of the 
temperature-dependent property correlations retrieved from PRO/II’s databanks. 
 

 Click the Component Properties button on the toolbar and from the Component Properties 
dialog box open the Temperature Dependent Properties dialog box. 
 

 Click the appropriate button to enter user-defined component properties or to replace data for 
library components.  
 

Table 3: Location of Temperature Dependent Properties 

Property Button 

Enthalpy of Vaporization 

Ideal Vapor Enthalpy  
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Liquid Density  

Liquid Thermal Conductivity  

Liquid Viscosity  

Saturated Liquid Enthalpy  

Solid Density  

Solid Heat Capacity  

Solid Vapor Pressure  

Surface Tension   

Vapor Pressure   

Vapor Thermal Conductivity  

Vapor Viscosity  
 
 
User Defined Properties 
 
You can enter global data for User-defined Special Properties by pushing the User-defined Special 
Properties button on the Component Properties dialog box. These global data will be used for all 
thermodynamic systems but may be overridden in each thermodynamic system. 
 
Solid Properties 
 
All solid properties, fixed and temperature-dependent, are entered in the same dialog boxes as for 
User-defined components. 

 
Structure Data 
 
Click the UNIFAC Structures button on the Component Properties dialog box to define UNIFAC 
structures for selected components. 
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Selecting the Thermodynamic Method 
Selecting the appropriate thermodynamic method for your flowsheet is a critically important 
decision. Obviously, if you choose a thermodynamic system that cannot accurately model the phase 
behavior of the process, the simulation results will be invalid.  

Inappropriate choice of thermodynamic model is the largest single source of error in process simulation 
and it is always a good idea to verify your selection of a thermodynamic system by comparing simulation 
results with actual plant operating data. Since it is not possible to develop a single thermodynamic method 
to model all chemicals under all conditions, PRO/II uses several different models. Each works well in some 
situations and poorly in others. It is up to you to select the most appropriate methods for your particular 
flowsheet. Polar components at high pressure should not be simulated with a thermodynamic method that 
was designed to model low pressure hydrocarbons. Just because a computer reports convergence to great 
precision does not mean you should believe that the answers accurately model your actual process. Use 
your experience and engineering judgment to check that results are reasonable 
 
Properties and Systems 
 
PRO/II offers numerous methods for calculating thermodynamic properties. Generally you must 
select methods for calculating these thermodynamic properties: 
 
• Equilibrium K-values 

 
• Enthalpies 

 
• Entropies 

 
• Densities. 

 
In PRO/II, thermodynamic methods are arranged into systems. When you choose a thermodynamic 
system, PROVISION will provide default methods for each of these thermodynamic properties. You 
may override these defaults. For example, if the Soave-Redlich-Kwong thermodynamic system is 
selected, the default liquid density method is API. You may replace this with another method, for 
example, Lee-Kesler, should you feel Lee-Kesler will predict the liquid densities more accurately.  
 

 Click the Thermodynamic Data button, which is outlined in red to show that some data are 
required.  

 
 In the Thermodynamic Data dialog box, click on a Category and choose a Primary Method from 

the selection shown.  
 

 Transfer your choice to the Defined Systems list by clicking the Add button. 
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 Figure 10: Thermodynamic Dialog Box. 
 
 

  To change a default, click the Modify button and make the desired changes. 

  
 
 
Figure 11:  Thermodynamic Data- Modification Dialog Box 

 
Ideal Methods 
 
Ideal methods calculate the mixture properties as weighted sums of the pure component properties. 
Each component’s contribution is proportional to its quantity in the mixture. While ideal methods 
often provide good approximations for enthalpies and densities, more sophisticated methods are 
almost always required for K-values.  
 
Generalized Correlations 
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Generalized correlations are empirical or semi-empirical methods, mostly based on the principle of 
corresponding states. They generally do not contain any adjustable binary parameters and are 
primarily useful for nonpolar hydrocarbon mixtures. Examples of generalized correlations include the 
Braun K-10 (BK-10) and Grayson-Streed (GS) methods. 
 
Equations of State (EOS) 
 
Equations of state are mathematical expressions relating the density, temperature, pressure, and 
composition of a fluid. From an equation of state, you can calculate component K-values as well as 
the departures of enthalpy and entropy from their ideal gas values. Well-known examples of 
equations of state are the ideal gas law and the Van der Waals equation. More modern equations of 
state include the Soave-Redlich-Kwong (SRK) and Peng-Robinson (PR) equations. These equations 
often involve the use of binary interaction parameters (usually denoted by kij) to account for 
interactions between different components. These parameters may be: 
 
• Obtained from PRO/II’s databanks or internal estimation techniques 
• Supplied by the user  
• Fit to experimental data. 

 
The basic SRK and PR equations are useful for systems of nonpolar hydrocarbons; more 
sophisticated modifications are available to better represent systems containing polar components 
and to calculate rigorous vapor-liquid-liquid equilibrium. 
 
Liquid Activity (LACT) Methods 
 
LACT methods calculate K-values by starting with an ideal solution and correcting the result with 
activity coefficients. The activity coefficients are calculated from a model for the excess Gibbs energy 
of the liquid mixture. The most commonly used methods are NRTL and UNIQUAC. Binary interaction 
parameters are usually necessary. They may be: 
 
• Obtained from PRO/II’s databanks 
• Estimated using the UNIFAC method 
• Supplied by the user 
• Fit to experimental data. 
 
 
Dissolved gases may be modeled with Henry’s Law, and a heat of mixing option may be used to 
correct for nonideality in the liquid enthalpy. If the necessary parameters are available, LACT 
methods can successfully describe a wide variety of nonideal mixtures (particularly mixtures of 
components having similar volatility) including mixtures exhibiting two liquid phases. 
 
 
Transport Property Methods 
 
All simulations require selection of a thermodynamic method. Some also require transport 
properties - viscosity, conductivity and so on. Transport properties, if required, are specified from the 
same dialog box.   The unit operations that need transport properties are: 
 

 column (hydraulics) 

 pipe 

 rigorous heat exchanger 

 dissolver 
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 depressuring unit 

 output tables 
 

Transport properties include: 
 

 Viscosity 

 Thermal conductivity 

 Vapor-liquid surface tension 

 Liquid diffusivity. 
 
Four calculational methods are available for computing transport properties: 
 

 Pure 

 Petroleum 

 Trapp 

 User-defined. 
 
The Pure option applies simple mixing rules to the temperature-dependent pure component values 
available in the selected databanks to calculate mixture transport properties. Saturation values are 
not pressure corrected. The Petroleum method uses predictive correlations, including pressure 
corrections, that apply to bulk hydrocarbon mixtures. The Trapp option uses a one fluid conformal 
model to calculate vapor and liquid viscosities and thermal conductivities for hydrocarbons; it uses 
the Petroleum method to calculate surface tension. The User-defined option allows you to provide up 
to five subroutines to compute transport properties. 
PRO/II provides a default method for each transport property when you select a transport method 
(except User-defined). You can choose to override these methods if necessary. For example, you may 
select the API Technical Data Book liquid viscosity method to replace the default Pure liquid viscosity 
method. Refer to the PRO/II Keyword Input Manual and the PRO/II Application Briefs Manual for 
selection of the proper transport property method. 
 
External Feed Streams 
 
You do not have to worry about resetting external feed streams. PRO/II automatically flashes these 
streams prior to flowsheet execution. Each stream is flashed using the thermodynamic system 
associated with the unit it feeds. Other user-supplied streams (such as initial estimates for recycle 
streams) are also flashed to be consistent with the units they feed. 
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Supplying Process Stream Data 
Streams and unit operations are the building blocks of a flowsheet. For each unit operation you must 
define at least one feed stream and at least one product stream. By defining the product from one 
unit operation as the feed to another, you establish the connections between the various units in the 
flowsheet. 
 
Types of Streams 

 
Even simple flowsheets can contain several different types of streams. 
 

 
 
External Feed Streams 
 
External feed streams originate outside the flowsheet. You must provide their thermal condition (e.g., 
temperature and pressure), their composition, and their flowrate. The components in your feed 
streams can come from PRO/II’s component library, from assay data, or from user-defined or 
petroleum components. 

 
Internal Feed Streams 
 
Internal feed streams are the product of one unit operation and the feed to another. Their properties 
are calculated by PRO/II and although you can provide data for their attributes these data will be 
overwritten by PRO/II as soon as the unit operation has solved. 

 
Product Streams 
 
Product streams exit the flowsheet. Their properties are calculated by PRO/II and you cannot provide 
any of their attributes. 
 
 
 
 
 
Recycle Streams 
 
Recycle streams are special internal feed streams that connect downstream units to upstream units. 
PRO/II automatically recognizes recycle loops and adjusts its calculations appropriately. You can 
provide estimates for recycle stream properties to help accelerate the solution but it is not usually 
necessary and a poor estimate is usually worse than no estimate at all. 

Internal
Feed

External
Feed

Product

Recycle

Product
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Recycle Convergence 
 
PRO/II accomplishes recycle convergence by solving the flowsheet sequentially using iterative 
techniques. PRO/II’s default iterative method is direct substitution. In this technique, the units are 
calculated sequentially many times. For example, if a recycle loop contains units A, B, and C, then 
the calculational sequence would be: A,B,C, A,B,C, A,B,C, ... Each pass through the loop constitutes 
an iteration. In the first iteration, the recycle stream has a flowrate of zero, unless you explicitly 
provide an estimate. At all other iterations, the recycle stream has the values that were calculated at 
the end of the previous iteration. The recycle loop has converged when the recycle stream changes 
are sufficiently small between two iterations. The magnitude of sufficiently small is determined by 
the various recycle convergence tolerance parameters that PRO/II uses (you are free to provide 
these values). 
 
You must be aware that iterative methods are usually not guaranteed to converge. Direct 
substitution, however, is fast and reliable for many problems, although it sometimes needs your 
help. If you can provide a good initial guess for a recycle stream, the loop may converge faster and 
more reliably. 
 
Because of the greatly increased number of computations, converging recycle loops can require 
large amounts of time. For this reason, PRO/II provides two methods to accelerate convergence. 
These are the Wegstein and Broyden methods. As is typical with many iterative techniques, they 
work well for some problems and might not work at all for others. Both of these methods seek to 
accelerate the direct substitution method by providing better estimates of the recycle stream at each 
iteration. Acceleration methods can often help with problems which tend to oscillate when using 
direct substitution alone or with problems which approach convergence asymptotically.  
 
Sequencing 
 
Another way you can control recycle loop convergence is by specifying the calculation sequence. 
PRO/II provides three sequencing options: 

 
• The default method, Minimum Tear Streams, orders the calculations to minimize the number of 

tear streams. You can think of a tear stream as a stream whose estimate you (or PRO/II) provide 
to break a recycle loop. 

 
• The Alternate method sequences the calculations roughly in the order that the units were 

entered. This was the default method in versions earlier than PRO/II 3.30. 
 

• The Explicitly Defined by User method allows you to choose the ordering of the calculations. 
 
Stream Properties 
 
Before you enter data for a stream, you should have placed the unit operations on your flowsheet 
and connected them together with feed, product, and recycle streams. You should also have 
declared the components that will be present in your simulation and specified the thermodynamic 
methods you want to be used. 
To define a stream completely you must specify its:  
 
• Thermal condition 
• Composition  
• Flowrate 
 
To open the Stream Data dialog box, double click on the stream, or right click on the stream and 
select Data Entry from the menu. 
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Figure 12: Stream Data Dialog Box 

 
Thermal Condition 

 
PRO/II requires that you provide the thermal condition for all external feed streams. You must also 
supply the stream thermal condition if you choose to enter a recycle estimate. To define the thermal 
condition, you must specify two of the following three properties: 
 
• Pressure 
• Temperature  
• Phase 

 
Temperature and/or Pressure 
 
From the First Specification drop-down list select either Temperature or Pressure. If you want to 
supply both, select Temperature here and Pressure as the Second Specification. Enter values in the 
fields supplied. 

  
 Phase 
 

Phase data are supplied as the Second Specification after you have supplied temperature or 
pressure. When defining the phase, you may specify the stream as one of: 
 
• a saturated liquid at its bubble point 
• a saturated vapor at its dew point 
• a mixed phase stream at a liquid fraction between 0.0 and 1.0. You may supply molar, weight or 

volume fraction data. Enter the value in the field provided. 
 
Composition and Flowrate 
 
PRO/II requires you to specify the composition and flowrate of all external feeds and estimated 
recycle streams. You can enter the composition of a stream in one of four ways: 
 
• Using defined components 
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• Using assay or distillation data 
• By referencing to another defined stream 
• By defining a stream as containing only solids 

 
 Select the stream type in the Stream Type list. You define the flowrate after choosing the stream 

type. 
 

Compositional Stream 
 
Compositional streams are made up of pure components: library, user-defined or petroleum. You 
must always provide the composition. 
 

 Click the Flowrate and Composition button to open the dialog box. 
 

 
Figure 13: Flowrate and Composition Dialog Box 
 
If you do not provide a rate, PRO/II adds the individual component flowrates to get the total rate.  
 
If you provide a total stream flowrate, the sum of individual compositions entered should be 1.0 
(fractions), 100 (percentages), or the flowrate that you supply. If not, select Normalize and PRO/II 
will adjust them for you. 
 
If a component does not exist in a particular stream, enter a zero value for that component.  
 
Both composition and flowrate may be given on a molar, weight, standard liquid volume or standard 
gas volume basis. You may mix bases. For example, you may enter the total flowrate on a molar 
basis and enter the component rates on a weight basis. 
 
To change the basis, click in the relevant field and click the UOM button on the top of the dialog box. 
 
Standard Conditions 
 
If you enter data on standard liquid or standard vapor volumetric bases, PRO/II will use the density 
of the phase you specify, regardless of the actual physical state of the stream at the specified 
thermal condition. 
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For liquid volume, PRO/II determines the molar flowrate using the liquid densities of the 
components at standard conditions (60°F and 1 atm.). In cases where a component is a vapor at 
standard conditions, the estimated density value comes from the GPSA handbook. If the GPSA value 
is unavailable, PRO/II extrapolates from the density of the saturated liquid at atmospheric pressure.  
 
For vapor volume, PRO/II uses the defined standard vapor conditions to determine the molar 
flowrate. The actual values of the standard temperature and pressure (and therefore the computed 
flowrate) depend on the default units of measure that you are using. For the metric and SI systems, 
STP defaults to 0°C and 1 atm of pressure. For English units, the STP default is 60°F and 1 atm of 
pressure. You can change the standard vapor conditions for your simulation using the Standard 
Vapor Conditions button on the Default Units of Measure for Problem Data Input dialog box. 
 
After determining the molar flowrate, PRO/II performs an internal flash to bring the stream from STP 
to the thermal condition that you have specified. 
 
Petroleum Assay Stream 

 
Assay streams differ from compositional streams by the way in which their compositions are entered 
and referenced. When you input an assay stream, instead of explicitly stating how much of each 
species is present, you provide simple experimental data. PRO/II uses that data to characterize the 
stream’s composition in terms of “petroleum components.”  

 
Typically, a laboratory-scale batch distillation analysis, such as the ASTM D86 procedure, is 
performed to characterize a crude stream. 

 
Assay Data Entry 
 

 Select Petroleum Assay in the Stream Type list. Click the Flowrate and Assay button to open the 
data entry window. 

PRO/II requires the following information for an assay stream: 

• Flowrate 
• Distillation Data  
• Gravity Data 

 
Flowrate 

Enter a value in the field. To change the basis, click the UOM button on the top of the dialog box. 

 
Figure 14:  Flowrate and Assay Dialog Box 
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 Click the Define/Edit Assay button to open the Assay Definition dialog box. Select a distillation 

type from the list: 
 

• True Boiling Point (TBP) 
• ASTM D86 
• ASTM D1160 
• ASTM D2887 

Note that the D86 and D1160 data are almost always reported on a liquid volume basis while the 
D2887 data are always reported on a weight basis. Your flowsheet may include different types of 
assay streams (e.g., one stream on a D86 basis and another on a TBP basis). 

If your distillations data has been collected at a pressure other than atmospheric (760 mm Hg), you 
must supply that pressure.  

 Enter the data in the Percent Distilled vs. Temperature table. 

 
Figure 15:  Assay Definition Dialog Box 

Gravity Data 

You must supply at least the average gravity for an assay stream, expressed as API gravity, Specific 
Gravity or Watson K-factor. If, in addition, you have a gravity versus percent distilled data curve, you 
should enter it for greater accuracy. Click the Gravity Curve button to enter the data. 

Optional Data 
The following data are optional:  

• Light Ends Analysis 
• Molecular Weight Data 
• Special Properties 

 



PRO/II Academic Manual 28

 

Light Ends Analysis 

Often you can identify and accurately measure the quantity of a few of the lighter components that 
are present in the petroleum stream. You can supply their rate and composition in terms of library 
components. Such precisely measured data naturally improves the accuracy of the characterization. 
If the light ends are included in the average gravity of the stream, enter them here by clicking the 
Lightends button and entering the data. If the light ends are not included in the average gravity of 
the stream, enter them as a separate compositional stream and mix with the assay stream. 

Molecular Weight Data 

If possible, you should provide measured molecular weight data because the molecular weight 
correlations are traditionally the least accurate of those used in hydrocarbon characterization. You 
may supply a molecular weight curve without supplying an average value. Click the Molecular Weight 
button to enter data. 

Refinery Inspection Properties and User-defined Properties 

Should they be available, you may include Refinery Inspection properties such as cloud point, pour 
point, sulfur content, and kinematic viscosity in assay form. Click the Refinery Inspection Properties 
button to enter data. 

You can also include custom defined Special Properties. Click the User-defined Special Properties 
button to enter data. 

Reference Stream 
 
A reference stream is a feed stream whose attributes are defined in terms of another stream (the 
referenced stream). The two streams have the same composition and can have the same rate 
(molar), temperature, and/or pressure. 
 
Select Referenced to Stream in the Stream Type list. Click the Flowrate and Stream button to open 
the data entry window 

 
Figure 16: Reference Stream Dialog Box 
 
Typically, when using this option, you transfer the composition of one stream (the source) to another 
(the target) while overriding the molar rate, temperature, and/or pressure. You may find the 
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reference stream feature most useful when the stream rate, temperature, and/or pressure change, 
but the composition remains the same.  

 
Solids Stream 
 
All streams may contain solids but there are some streams which contain only solids. These are 
handled differently in PRO/II. Solids-only streams contain only components which have been defined 
as solid components on the Component Phase Selection dialog box, accessed from the Component 
Selection dialog box. 
 

 In the Stream Data dialog box, select Solids Only Stream in the Stream Type list. Click the 
Stream Solids Data button to open the dialog box. 

 
 

 
Figure 17:  Solid Components Dialog Box 
 

 
 Click the appropriate Enter Data button to enter molar or weight based solids flowrate and 

composition. Solid components which do not have molecular weight defined may be entered 
only on a weight basis. 

 
If you have entered particle size distribution or general attribute data for at least one solid 
component you may click the Solids Attribute Enter Data button to enter particle size distribution and 
General Attribute data. 
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Supplying Process Unit Operations Data 
PRO/II is a sequential modular simulator. Each unit is calculated separately with the calculations 
proceeding in a stepwise fashion from one unit to another.  
 
PRO/II uses the unit operations concept to construct the flowsheet. You must define the unit 
operating conditions, e.g., the outlet temperature of a heat exchanger or the reflux ratio for a 
column. 

 
` Common Features of all Unit Operations 
  
 All unit operations have some common features: 
 

• Unit identifier and a description. The unit identifier identifies the unit within the PRO/II 
calculations and is used in sequencing and specifications. PRO/II supplies identifiers for you 
automatically. 

• Multiple Feeds 
• Thermodynamic Options 
• Product Phases 
 
Multiple Feeds 

 
You can supply any number of feeds to a unit. Exceptions to this rule are highlighted when the unit 
operation is described. 
 
When you do not provide a unit’s pressure, PRO/II sets it to the lowest feed pressure and PRO/II 
mixes all feeds adiabatically at this pressure.  

 
Thermo Options 
 
If you have defined more than one thermodynamic system for your simulation, you can specify which 
of the defined thermodynamic systems is to be used for the calculations of a specific unit operation. 
Select the thermodynamic system from the list of available choices within the unit operation.  
 
The default system used for the thermodynamic calculations within individual unit operations is that 
selected as Default System in the Thermodynamic Data dialog box. 
 
If the default system is changed, unit operations that have the default choice selected for their 
thermodynamic method calculations will automatically use the new default system 
 
For unit operations that have an alternative thermodynamic system selected, changing the default 
system in the Thermodynamic Data dialog box will not change the thermodynamic method used 
within that unit operation. 
 
 
Product Phases 
 
Most unit operations allow you to split the product into one or more streams. You can assign the 
following phases to product streams: 
 
• Vapor 
• Liquid 
• Solid 
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• Decanted Water 
• Second (heavy) Liquid 
• Vapor + Liquid (Mixture) 

 
Exceptions to this rule are: 
 
• Simple heat exchanger—the rule applies to both sides of a simple HX. 
• Rigorous heat exchanger—the rule applies to both sides of a rigorous HX 
• LNG exchanger—the rule applies to all cells of an LNG exchanger 
• Flash—has to be the Flash with Solids to have a solid phase 
• Pump—only one product allowed 
• Depressuring—as many products as there are time intervals 
• Solid units—one solid and one liquid (with or without solids); or one solid and one gas (with or 

without solids). 
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Running the Simulation 
Interactive Run Capabilities 
 
To run your PRO/II simulation interactively, you have two options: the Run button on the toolbar and 
the buttons on the Run palette. 

 
The easiest way to run your simulation interactively is to click the Run button on the toolbar. This 
button will be bordered in red until you have entered the required input data. If you don’t need to add 
breakpoints or otherwise step through your simulation, this is your quickest method.  

 
You can stop an ongoing simulation using the Stop button and restart it with the Run button, if 
desired. 
 
The Run Palette 

 
For more control over your interactive simulation, use the buttons on the Run palette. Through the 
Run palette you can perform any of the following tasks: 
 
• Check the consistency of your input data. 
• Set breakpoints and step through a simulation. 
• View the flowsheet convergence and simulation results. 
 
To view the Run palette, choose View/Palettes from the menu bar and highlight Run. PRO/II disables 
the buttons on this palette until you have supplied all required input data (i.e., there are no red-
bordered buttons, unit identifiers, or stream identifiers). Table 4 describes the Run palette buttons 
and their functions. 
 

Table 4: Run Palette Buttons 

Button Function 

Status Enables you to view global status messages for the current simulation. 

Check Data Checks the input data for inconsistencies. 

Run Executes the simulation, either from the beginning or from a breakpoint. 
Before execution, the input data is checked for inconsistencies. 

Step Enables you to step through the execution of the simulation by stopping at 
each unit operation in the calculation sequence. 

Stop Stops the simulation during execution. PRO/II completes its current 
calculation before stopping. 

Set Breakpoints Enables you to select the units you want to assign as breakpoints. When the 
simulation is executed, it stops at these breakpoints. 

Goto Enables you to start the execution from any specified unit. You select a unit by 
highlighting it and then clicking this button. 

Messages Enables you to view the calculation history and any error messages that arise. 

View Results Enables you to view detailed output results of a highlighted unit operation or 
stream in the flowsheet of a simulation. 

Show Breakpoints Enables you to see which units are assigned as breakpoints, by displaying 
these unit icons in magenta. Clicking the button a second time causes the 
flowsheet to revert to normal display. 
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Unit Color Coding 
 

As your simulation progresses, individual unit operations change color (unless you disable the Show 
Run Colors option from the View menu). Table 5 details the relationship between the unit status and 
its color. 

 
Table 5: Unit Color Coding 

Color  Significance During Simulation Execution 

Pale Green Unit operation has not been calculated. 

Red Unit operation has failed to solve. 

Green Unit operation is in the process of being calculated. 

Blue Unit operation has been solved. 

Magenta Unit operation is at a breakpoint. 

Dark Blue Unit operation was solved in a previous run. 

 



PRO/II Academic Manual 34



PRO/II Academic Manual 35

 

 

 

 

 

 

 

 

 

 

 

TECHNICAL REFERENCE SECTION 



PRO/II Academic Manual 36

Using Specification and Define Features 

The Specification and Define features of PRO/II allow you to control your simulation to meet your 
modeling requirements. Using Specification and Define you enter target values for flowsheet 
parameters. PRO/II meets these targets either directly or by adjusting the values of other 
parameters. 
 
Specification 

 
Using Specification you set a target value of a calculated unit operating condition or stream property. 
PRO/II meets it by varying other parameters either within the unit operation or elsewhere in the 
flowsheet. You can express Specifications either as actual values or as functions of other 
parameters. For example, you can Specify a product stream flowrate as 1000 and a flash drum 
temperature as its feed temperature plus 10 degrees. 
 
Define 

 
Using Define you link the value of a variable to that of an upstream variable that has already been 
calculated. For example, you can Define a FLASH DRUM pressure as equal to the pressure of an 
upstream valve minus 0.1 bars. 
 
Specification 
 
You can make specifications on parameters within a unit operation or parameters of product 
streams from the unit operation.. The number of specifications you can make in a unit operation 
depends on the number of degrees of freedom that are available to the equations that solve the unit. 
For example, in a SPLITTER you can make N-1 specifications where N is the number of products. The 
Nth product is calculated from the equation matrix. 
 
Absolute Specification 
 
Suppose you want to specify that the selected stream should contain 100 kg moles/hr of butane. 

 In the Parameter Selection dialog box, select Flowrate then Selected Components, then NC4 as 
Starting Component.  

 Return to the Flash Drum dialog box, click on value and enter 100. Your absolute stream 
specification has been set: 

 
 
 
 
 
 
Relative Specification 
 
Suppose you want to formulate your specification as a function of another parameter in the 
flowsheet. Specify that 95% of the butane in the feed is recovered in the selected product stream. 

 
 Click on = in the linked text on the Flash Drum dialog box and click on / parameter.  

The linked text changes to  
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 Select the first parameter as described above.  

 For the second parameter, select Total Unit Feed from the Constant/Stream/Unit list on the 
Parameter dialog box, then select the parameter as before.  

 
 

 
 Return to the Flash Drum dialog box, click on value and enter 0.95. Your relative specification is 

now complete. 
 
 

Note: Infeasible specifications are the leading cause of non-convergence of flowsheets. The 
specifications you provide must be realistic. For example, if a unit’s feed streams contain 
100 kg/sec of hexane, it would be infeasible to specify a product recovery rate of 120 
kg/sec of hexane. 

 
 Define 

 
The Define feature allows you to dynamically link the value of a variable to that of an upstream 
variable that has already been calculated. Whenever the upstream variable changes, perhaps as a 
result of being in a recycle loop, the value of the Defined variable also changes according to the 
Definition you have made. You can define almost any input parameter.  
 
You know if a parameter is Definable by the state of the Define button on the toolbar. Click in the 
field you want to define. If the Define button is enabled you can define the parameter. 
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Flash Drum 
Flash Calculations 

 
When you perform design calculations or troubleshoot a process, you may need to know a mixture’s 
phase behavior at certain process conditions, or you may need to know what conditions are 
necessary to recover a certain amount of a component from a mixture. Usually you must rely on a 
process simulator to get this type of information. 

 
Flash Unit Operation 
 
Figure 18 shows a general schematic of the PRO/II FLASH unit for a vapor-liquid system. PRO/II 
allows up to three products for this unit and an unlimited number of feeds. 

 

 Figure 18:  Three-Phase Equilibrium Flash Unit Operation 
 

Note that Fj denotes the feed streams, V denotes the vapor product, L denotes the liquid product, W 
denotes either the decanted water or the second liquid product, and zji, yi, x1i, and x2i denote the 
component mole fractions for the respective streams. Q denotes the duty added or removed from 
the flash unit operation. 
 

 Defining the Flash Calculation  
    

From the set of equations given above, you can see that Eq. (3) sets the phase equilibrium behavior 
for the system. In Eq. (3) the phase equilibrium ratios or Ki’s (also referred to as K-values) are 
typically functions of temperature, pressure, and composition, making the problem fairly complex. 
Your selection of a thermodynamic system for the process will greatly affect the solution. 
 
As previously discussed, there are N+3 variables to be specified for each calculation. The feed 
stream composition and rate comprise N+1 of these variables. This leaves two degrees of freedom 
to be set in the flash algorithm. PRO/II requires you to specify either the flash temperature or 
pressure. In addition, you must provide one of the following parameters: 
 
• Flash temperature 
• Flash pressure or pressure drop 
• Duty required 

F1, z1i

FM, zMi

V, yi

L, x1i

W, x2i

Q
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• Product phase (saturated liquid, saturated vapor, or liquid fraction) 
• Product stream rate 
• Product stream composition  
• Product stream property (e.g., TVP or specific gravity). 
 
The first three parameters represent process operating conditions that you can physically control. 
The remainder are design or performance objectives that you want to achieve.  
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F1, z1i

Fn, zni

Fo1, zo1i

Fo2, zo2i

Fom, zomi

Valve, Mixer, and Splitter Unit Operations 
The VALVE, MIXER, and SPLITTER units also perform phase equilibrium calculations. They are each 
equivalent to an adiabatic flash with zero enthalpy change (duty=0). The temperature is always 
computed rather than specified, and PRO/II allows an unlimited number of feeds to these units. You 
can set the pressure or pressure drop; otherwise PRO/II assumes a pressure drop of zero and uses 
the lowest feed pressure for the product streams. Figures 9-11 depict the schematics for these unit 
operations. 

 

 Figure 19:  Valve Unit Operation 
 

The VALVE unit can have up to three products. Designation and handling of the products for the VALVE 
unit is as flexible as for the FLASH unit. MIXER units may only have one product; however, PRO/II 
always determines the product phase, regardless of which phase (V, L, W, or M) you designate. 

 

 
 
  
 Figure 20:  Mixer Unit Operation 
 
 
 
 
 
 
 
 
 
 
 

Figure 21: Splitter Unit Operation 
 
 

The SPLITTER unit combines any number of feed streams and splits the combined feed into products 
of identical composition and thermal condition. The same phase designation must be used for all 
products (i.e., liquid, vapor, etc.). If you select an incorrect phase designation, PRO/II will reset it to 
the correct phase, as with the other equilibrium calculation units. 
In addition, you must define the stream rates using generalized stream specifications for all but one 
of the desired products. The splitter unit allows only rate dependent stream specifications. For 
example, the rate of a component or group of components in a product is a rate dependent 
specification. The recovery of a fraction of the total feed to the splitter is also a rate dependent 
specification.

F1, z1i

Fn, zni

V, yi

L, x1i

L2, x2i

F1, z1i

Fn, zni

Fo, zoi
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Compressors  

The Compressor simulates a single stage isentropic compression. Outlet conditions and work 
requirements may be determined using either an adiabatic or polytropic efficiency. Optional tabular 
input may be used to determine performance from supplied curves for outlet pressure or pressure 
ratio, head, work, and/or efficiency. An optional aftercooler calculation may be included. Both VLE 
and VLLE calculations are supported. Multistage compressors may be modeled by linking single 

stage compressor units.  
 
 
 
 
 
 
 
 
 
 
 
 

Figure 4:  Compressor Unit Operation 
 
Feeds and Products  
 
A compressor operation may have multiple feed streams, in which case the inlet pressure is 
assumed to be the lowest feed stream pressure.  
 
Compressors may have one or more product streams. The product phase condition for units with one 
product stream is automatically set by PRO/II. For compressors with two or more product streams, 
the product phases must be specified in the Product Phases window which is accessed by clicking 
Product Phases… on the Compressor main data entry window. Note that for compressors with 
aftercoolers, the products correspond to outlet conditions from the aftercooler.  
 
Product phases allowable include: vapor, liquid, decanted water, heavy liquid, and mixed phase 
(vapor plus liquid). Mixed phase is mutually exclusive with vapor and liquid products and is not 
allowed when four product streams are specified.  

 
 Specifications 
 

The pressure, work, or head specification is selected from the drop-down list box in the Compressor 
main data entry window.  At lease one specification must be supplied for every compressor.  In 
addition, the efficiency or outlet temperature can also be specified.   
 
 

 
 
 
 
 
 



PRO/II Academic Manual 42

Heat Exchangers 
The Simple Heat Exchanger may be used to heat or cool a single process stream, exchange heat 
between two process streams, or exchange heat between a process stream and a utility stream. 
Rigorous calculations may be performed for VLLE systems. It is also possible to attach an exchanger 
to any tray of a distillation column and exchange heat between a process stream and a column 
internal stream, either liquid or vapor.  

 
  
 
 
 
 
 
 
 
 
 
 
 

 
Figure 5:  The Heat Exchanger Unit Operation 
 
Feeds and Products  

 
For reference, streams and products are grouped according to the side of the exchanger as “hot” or 
“cold”, where the feed stream(s) on the hot side are cooled and the feed stream(s) on the cold side 
are heated. Multiple process feed streams are permitted, with the lowest stream pressure used as 
the inlet pressure.  
 
The product from each side of an exchanger may be phase separated as desired into multiple 
product streams, where products may be liquid, vapor, mixed phase, and decanted water 
(hydrocarbon systems only). The “water” product stream may also be used to represent a second 
liquid phase for systems in which rigorous modeling of VLLE thermodynamics is considered.  
 
Feed and product streams are accessed via the Heat Exchanger Process Streams window which is 
opened by clicking Process Stream… on the Heat Exchanger main data entry window. The product 
phase condition for units with one product stream is automatically set by PRO/II. For simple heat 
exchangers with two or more product streams from a given side, the product phases must be 
specified in the Product Phases window accessible by clicking Product Phases… on the Heat 
Exchanger Process Streams window.  
 
Product phases allowable include: vapor, liquid, decanted water, heavy liquid, and mixed phase 
(vapor plus liquid). Mixed phase is mutually exclusive with vapor and liquid products and is not 
allowed when four product streams are specified. 
 
Utility Streams  
 
For simple heat exchangers with one process side, a hot or cold utility stream may be defined. The 
required utility rate for the specified heat transfer is always computed. Utility streams may be specified 
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by clicking Utility Stream… on the Heat Exchanger main data entry window to access the appropriate 
hot or cold utility window.  
 
Cold utility streams are supplied in the Heat Exchanger Cold Side Utility window. Options are:  
 
• Water: Temperature in and out must be supplied. Sensible heat transfer only.  
• Air: Temperature in and out must be supplied. Sensible heat transfer only.  
• Refrigerant: A designated component is vaporized at its saturation pressure or temperature. Latent 

heat transfer only.  
 
Hot utility streams are supplied in the Heat Exchanger Hot Side Utility window. Options are:  
 
• Steam: Steam is condensed at its saturation temperature or pressure. Latent heat transfer only.  
• Heating Medium: A designated component is condensed at its saturation temperature or pressure. 

Latent heat transfer only.  
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Pumps 
The Pump may be used to compute the energy required to increase the pressure of a process stream. 
This quantity of energy is added to the feed enthalpy to determine the outlet temperature. Only the bulk 
liquid phase is considered in the calculations.  

 
 
 
 
 
 
  

Figure 6:  The Pump Unit Operation 
 

Feeds and Products  
 
A pump operation may have multiple feed streams, in which case the inlet pressure is assumed to be 
the lowest feed stream pressure. A single liquid product stream is allowed from a pump.  

 
Specifications  
 
The Pressure Specification for a pump is selected with the appropriate radio button on the Pump main 
data entry window as:  
 
• Outlet Pressure 
• Pressure Rise (∆P) 
• Pressure ratio based on the lowest feed stream pressure. 
 
Pump Efficiency  
 
A pumping efficiency in percent may be supplied in the data entry field provided on the Pump main 
data entry window. This value is used for the work and outlet temperature calculations. If not supplied, 
a default value of 100 percent is used.  

 
Thermodynamic System  

 
The thermodynamic system of methods to be used for pump calculations may be selected by choosing 
a method from the Thermodynamic System drop-down list box on the Pump main data entry window.  
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Generating Output 
PRO/II helps you generate accurate, professional reports. The standard output report format gives you 
comprehensive information on all unit operations and stream properties. Or, you can enhance your own 
reports by including plots, tables, and flowsheet diagrams from PRO/II. You have a wide variety of 
options at your fingertips for tailoring your simulation results to meet your specific needs including: 
customizing the output report format, exporting data to spreadsheet programs, creating plots and 
tables, and annotating your flowsheet.  

 
 
 Interactive Output 
 

You can interactively view summary results for units and streams. For individual units, right click on the 
unit and select View Results from the menu. For individual streams, right click on the unit and select 
View Results from the menu. 

You can present stream data on the Process Flow Diagram in the form of stream labels. A Stream 
Property Table is also very effective. 

By default, the stream label shows the stream identifier. You can present more information on the 
stream label. Right-click on a stream and select Display from the menu. In the Stream Style dialog box, 
set desired style. 
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Figure 22: Stream Style Dialog Box 

 
If you make the selections shown above, you get this label display: 

 

 
Stream Property Tables 
PRO/II’s STREAM PROPERTY TABLE feature displays and prints data for flowsheet streams.  

To create a STREAM PROPERTY TABLE:  

 Choose Options/Stream Property Table from the menu bar, or click the STREAM PROPERTY TABLE 
button on the PFD palette. A green outline appears attached to the cursor.  

 Anchor the table to the PFD by clicking the left mouse button at the desired location. 

 Double-click on the table to open the Stream Property Table dialog box. 
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Figure 23: Stream Property Table Dialog Box 

 Select a table type from the Property List to be Used list. Change the table’s appearance using 
entries in the Table Appearance box. Select the streams you want displayed. 

The simplest property table is the Short Property List which shows the stream attributes below. 

Note: If you want to define your own table, select Stream Property Lists on the Options menu. When 
you have defined your table, return to the Stream Property Table dialog box. Your table will 
appear in the Property List to be Used list. 

 Exporting Data 
 

You can save a STREAM PROPERTY TABLE to a file by highlighting the table and choosing File/Export... from 
the menu bar. Select Stream Property Table as the data to export. The table can be saved as either tab-
delimited text or comma-delimited text. Once you’ve saved your STREAM PROPERTY TABLE as a text file, you 
can import it into Microsoft Excel (or any other spreadsheet program) and then use its data processing 
capabilities to manipulate and process your data. 

You can save the flowsheet diagram to the Clipboard using the Export... option from the File menu on 
the main menu bar. You can then import the flowsheet diagram into other Windows applications using 
the Clipboard. 

You can print the complete flowsheet diagram directly to the printer by selecting File/Print from the 
menu bar. Select Print Setup from the File menu to set the default printer and to choose the print 
options. 
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Output Report 
 

You can examine most of your simulation results through the output report (.OUT file). PRO/II contains a 
wide variety of report options for customizing your output format. To set these options, select Report 
Format from the Output menu. From the sub-menu select: 

 Units of Measure to customize output units of measure and elect to have two outputs: one in input 
units and the other in output units. 

 Miscellaneous Data to customize report size, input reprint, overall mass balance and various other 
options. 

 Stream Properties to customize stream output bases, TBP reports and other stream-oriented items. 

 Unit Operations to customize individual unit operation output formats. 

 
 

Units of Measure 

On the Default Units of Measure for Problem Output Report dialog box, you can choose the units to be 
used for your output report. By default, the output units of measure set is identical to the input set. If 
you choose to use a different set for the output, you can use either a library set or the input set as a 
basis and you can modify the units used for individual properties as desired. 

You can also choose to print out two output reports, one in input measurements and a second in the 
units of your choice. A single output file will contain both reports. 
 
Miscellaneous Data 
 
In the Miscellaneous Report Options dialog box, you can choose, amongst other things, which portions 
of the input data you would like reported and whether to include the flowsheet mass balance in your 
output report. 
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 Figure 24:  Miscellaneous Report Options Dialog Box 

 
Stream Properties 
 
You can choose the way in which your stream data are reported by selecting Stream Properties from 
the Report Format menu. 

 
 
 Figure 25:  Stream Property Report Options Dialog Box 
 
  
 
 
 Unit Operations 
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You can set print options for individual FLASH DRUMS, COLUMNS, and REACTORS by 

selecting Unit Operations from the Report Format menu. 

 
 Figure 26:  Print Options Dialog Box 
 

Highlight the unit of interest, and click the Print Options button. The Print Options dialog box for the 
highlighted unit appears and you can choose which items you want included in your output report. For 
FLASH DRUMS, you can choose whether or not to print Component K-values and for REACTORS, you can 
toggle the option of printing the calculation path for the enthalpy balance. Figure 53 shows the print 
options for COLUMNS. 

 
 Figure 27:  Column Print Options Dialog Box 
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Alternatively, you can double-click on the individual unit operation on the PFD and click the Print 
Options button to get the Print Options dialog box. 

Generating a Report 

To generate an output report for your simulation, click the Generate Report button on the toolbar or 
select View/Generate Report from the menu bar. The default editor appears displaying the contents of 
your output report. PRO/II appends the .OUT extension to your file name and saves the output file in the 
same directory that you saved your simulation files. The default directory is C:\SIMSCI\PROII_W\USER. 
 
Once you have created your output report, you can view it at any time by selecting Output/View Report 
from the menu bar. Your default text editor displays the output report. 

Plots 
You can generate and display a variety of graphical plots for your output data. PRO/II plots output 
results for: 

• COLUMN internal flowrates, temperature, and composition 

• COLUMN separation factor, used for the analysis of column feed point and tray performance 

• HEAT EXCHANGER zone analysis 

• PHASE ENVELOPES 

• HEATING/COOLING CURVES 

• Case Study results 

• Physical Properties 

• Feed stream assay curves 

Plot Drivers 

PRO/II can display plots using the SIMSCI driver or the following third party packages, such as Microsoft 
Excel and GNUPLOT (Microsoft Windows version).  

With Microsoft Excel, you can change plot colors, axis titles and other attributes to create a presentation 
quality graph. Microsoft Excel charts can be easily imported into Microsoft Word documents and 
PowerPoint presentations using the Insert Object option. 

GNUPLOT is a command-driven interactive plotting program. You can use it to plot both two and three-
dimensional plots in many different formats. 

 To change your plot driver, choose Output/Plot Setup from the menu bar. 

 

Generating Plots 
To generate plots in PRO/II: 

 Select Generate Plot from the Output menu.  
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 Select a unit and an Available Plot, and click the Plot button.  

You can: 

• Copy your plot to the Clipboard. 

• Export the plot data to a file as either tab-delimited text or comma-delimited text. 

• Print your plot. 

• Save your plot for future reference. 

• Open previously saved plots. 

Exporting Plots to Excel 
 

You can export data to Microsoft Excel. Select Tools/Spreadsheet from the menu bar. You can export: 

• plots 

• column reports 

• stream properties 

• component rates 
 

Open an existing table or plot and select File/Export from the graph window to save the data. 
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Online Help 
PRO/II incorporates an online Help system, a comprehensive reference tool that quickly accesses 
information. Online answers are instantly available while you work. In the Help system, commands, 
features, and data fields are explained in easy steps. You can access the electronic Contents for the 
Help system by selecting Help/Contents from the PRO/II menu bar. Context-sensitive help is accessed 
using the <F1> key or the What’s This? button by placing the cursor in the area in question. 

 
 When you have a Question: 
 

• First, try using the documentation available on your own computer.  The guides and manuals 
mentioned here were installed as part of a normal installation of PRO/II. 

• Use the on-line help system.  PRO/II provides context-specific help in all the data entry windows.  In 
the PFD Main Window, you can enter "Help Mode" by selecting the What is command in the Help 
menu, or by clicking the What is button on the Toolbar. 

• Follow the sample problems given in the PRO/II Tutorial Guide. 

• Read the Troubleshooting section of the PRO/II Installation Guide.  It contains information on 
common problem areas and error messages. 

• Next, use the available internet resources.  There is a wealth of information provided by Simsci-
Esscor. 

• Visit the Simsci-Esscor web site and explore the product knowledge base.  Answers to many 
technical questions are available there. 
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Working with Keyword Input Files 
Keyword Input files (.INP) are free format ASCII text tiles that define a PRO/II simulation using specific 
commands known as keywords.  You can import, export, and run keyword files within the PROVISION.  
Keyword files play many important roles in PRO/II: 

 
• They provide an alternate interface with the PRO/II calculational module. 
• They allow you to maintain compatibility with simulations that were run with earlier versions of 

PRO/II. 
• They provide a compact means of storing simulation input. 
• If you have several similar flowsheets to run, you can create the first simulation within the GUI and 

then modify its keyword file and run the rest using File/Run Batch. 
 

You can import existing keyword files in the GUI using the Import… option from the File menu.  This 
produces a .PRZ file within PROVISION if all the features are supported. 
 
To generate a keyword file from your existing simulation file, choose the Export… option from the File 
menu and select Simulation Data to Keyword File.  Enter the path and file name and click OK.  By 
default, keyword files have the extension .INP. 
 
Keyword files are easy to read and understand, and data care entered in the following order: 
 
 GENERAL DATA 
 COMPONENT DATA 
 THERMODYNAMIC DATA 
 STREAM DATA 
 REACTION DATA 
 PROCEDURE DATA 
 UNIT OPERATIONS DATA 
 CASE STUDY DATA 
 
You can run keyword files using the Run Batch option from the File menu. 
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Exercises 
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Chiller Plant Part 1 
Through guided practice, you will build a simulation of the process shown below. This is part of a chiller 
plant typical in natural gas processing. In subsequent parts of this example, you will add other sections 
of the plant to this simulation. 

 

 Figure 1:  Schematic of Chiller Plant – Part 1 

 
The process and equipment data are given in Tables 1 and 2. 

 

Table 6: Feed Stream Data 

Component Mole% Component Mole% 
Nitrogen 

Carbon dioxide 

Methane 

Ethane 

Propane 

1.0 

1.6 

72.5 

11.5 

6.75 

i-Butane 

n-Butane 

i-Pentane 

n-Pentane 

C6PLUS (PETRO Component) 

1.25 

3.0 

0.55 

1.10 

0.75  

Total Flowrate 4 X 107 standard vap ft3/day 

Temperature 120°F 

Pressure 205 psig 

C6PLUS  Properties NBP 210ºF 

 API Gravity 73 

   
   
   
   
   
   
   

Compressor
C-1

HX-1
Cooler

D-2
Knockout
Drum

P-1
Pump

D-1
Scrubber

Inlet
Gas

2 4 5

6

7

3 17
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Table 7: Equipment Data and Operating Conditions 

Unit Description Data 

D-1 Scrubber Temperature = 85°F 
Pressure = 203psig 

C-1 

 

Compressor Outlet Pressure = 600 psig 
Adiabatic Efficiency = 72% 

HX-1 Cooler Hotside: Process Stream 

Outlet Temperature = 110°F 
Pressure Drop = 5 psi 

Coldside: Utility Air 

Inlet Temperature = 80°F 
Outlet Temperature = 100°F 

D-2 Knockout drum Flash drum with no change of pressure and no duty. 

P-1 Pump Outlet Pressure = 550 psig 
Efficiency = 65% 
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Solution: Chiller Plant Part 1 
Step 1:  Create a New Simulation 

 Select New... from the File menu. 

Note that several buttons on the toolbar, including the Run button have red borders. When you have 
satisfied PRO/II’s input requirements all red borders will disappear. 

 
Step 2:  Build the Process Flow Diagram 
If the PFD palette is not already visible, click the PFD Palette button on the toolbar to bring it up. Click 
on the appropriate unit icons on the PFD palette to draw the PFD. To select and position a unit, just click 
on its icon. 

A pointer with a box and flash drum attached appears. Move this to the main window and click again 
when the unit is in position. 

In this manner, select and position the units as shown in the diagram using these PFD buttons: 

    

 Click on the red-bordered Streams button on the PFD palette.  

Note that the pointer now has an S attached to it. All available exit ports appear on each unit once you 
select the Streams button. Required exit ports are red and optional exit ports are green.  

 Draw the streams on the flowsheet to connect the units.  

After your first click, only the available feed ports are shown in red or green. 

Note: Although not critical in this example, it is good practice to connect the FLASH DRUM hydrocarbon 
liquid product to the side port and to reserve the bottom port for a decanted water or second 
liquid product. 

 Double-click on each stream and unit and change its name to that shown on the diagram above. Do 
not change any other data in the dialog box. Click OK to exit the dialog box. Note that spaces are 
not allowed in unit or stream names.  

 
The completed PFD should now look like Figure 2 below. 
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Figure 2:  Chiller Plant PFD in PRO/II 
 

After you finish building the flowsheet, the labels of all the internal streams are black and the available 
ports of all the units are green. At this point, all the unit labels have red borders and the border of the 
feed stream label is also red because you must still add data. Note that the border of the Streams 
button is black, indicating that you have entered all necessary data for this function. To exit the stream 
connection mode, right-click, or click on the Streams button so that it turns gray, indicating that the 
mode is no longer active. 
 

 Before continuing, save the simulation as CHILL1.PRZ. 

Step 3:  Modify the Input Units of Measure 
 Click on the green-bordered UOM button on the toolbar to verify the units of measure used in this 

simulation. 

For this example, you will use either modified SI units or modified English units.  Click Initialize from 
Library… and select ENGLISH-SET1 or SI-SET1 from the drop down list. 

 Check each item that it matches the input data given in the tables above. 

 Make any necessary changes and click OK. 

Notice that the border of the UOM button is now blue indicating that you have modified the data. 
 

Step 4:  Define the Components 
 Click on the red-bordered Component Selection button on the toolbar. 

 Click the Select from Lists button.  

 Select the Hydrocarbon Lightends Component Family and select components from the list 
displayed. Select a single component or a group of components (using the shift or control keys) and 
then click the Add Components button to add them to the component list below.  

 Add the components in the order presented in Table 6.  

 
 Figure 3:  Component Selection 
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 When finished click OK to return to the Component Selection dialog box. 

 Enter data for the petroleum component C6PLUS by clicking the Petroleum button.  

 Enter its name, NBP and gravity data, and click OK. 

Note that the Petroleum Component button and List of Selected Components box now have blue 
borders. 

 Click OK to exit the dialog box. 
 

Step 5:  Select the Thermodynamic Method 
 Click on the red-bordered Thermodynamic Data button on the toolbar.  

 Select the Most Commonly Used Category, and then select Peng-Robinson as the Primary Method.  

 Double-click on Peng-Robinson, or click the Add -> button to add your method selection to the 
Defined Systems box. 

 To specify the transport property methods, click the Modify… button and then the Transport 
Properties… button.  

 Check the Compute Transport Properties option and select Petroleum Correlations from the 
Transport System drop-down list, as shown in Figure 4. 

 
 Figure 4:  Transport Properties 
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 Click OK in each of the three dialog boxes to save the entered data. 

 
Step 6:  Define the External Feed Stream 

 Double-click on the feed stream INLET_GAS. Make sure that the stream type is Composition 
Defined.  

 Enter the stream’s thermal condition:  

• Select Temperature as the first specification and enter value. 

• Select Pressure as the second specification and enter value. 

 Click the Flowrate and Composition… button.  

 Select Total Fluid Flowrate and enter value. 

You will need to locally override the flowrate dimensional units. To do so, with the cursor in the fluid 
flowrate field, click the UOM button at the top of the dialog box and change the basis to vapor volume 
and the units to ft3 and day. Select the Change Units button to return to the dialog box. 

 Enter the individual component mole percentages into the component grid. You can move down the 
list using the Tab key. After entering the composition data, check that the total equals 100. 

 Click OK to exit each dialog box and return to the PFD. 

You do not need to enter data for any streams other than the INLET_GAS (the external feed stream to 
the process) because PRO/II calculates the others for you, based on your process conditions. 

 
 
Step 7:  Enter Operating Conditions for Each Unit Operation 

 Double-click on each unit in turn and enter the required data including the unit identifier.  

 Enter data for flash drum D-1. The First Specification is Pressure and the Second Specification is 
Temperature. 
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 Enter data for flash drum D-2. The First Specification is Pressure Drop and the Second Specification 
is Duty. The duty of an adiabatic flash is zero. 

 

Note:  As you return to the PFD after each unit operation, its unit identifier has changed from red 
(data missing) to black (data satisfied). 

 
 Enter data for heat exchanger HX-1.  

 

Note:  By default, the horizontal stream is the hot side and the vertical stream is the cold side. Here 
this means that the utility stream is the cold side. You could use this dialog box to change the 
stream allocations if the reverse were true. 

 Click the Specification button to open the Specifications dialog box.  

 Select Hot Product Temperature from the list and enter value. 

 
Figure 5:  Heat Exchanger Specifications 

 
 Return to the Heat Exchanger dialog box by clicking OK.  

 Click the cold side Utility Stream button and enter the appropriate data. 

 
 
 
 
 
 
 
Figure 6:  Cold Side Utility Stream 
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 Close the Heat Exchanger dialog boxes and return to the PFD. 

 Enter data for Pump P-1. In the Pump dialog box, enter pressure and efficiency data. 

 Enter data for compressor C-1. Enter values for Outlet Pressure and Adiabatic Efficiency. 

When you have entered all the data, there should not be any red on the flowsheet. All stream and unit 
labels should have black borders. If any of the unit or stream labels has a red border, click on it and 
check the data. Save the simulation before continuing. 

Step 8:  Run the Simulation and View the Results 
 Run the simulation by clicking the Run button on the toolbar. Each unit should turn green and then 

blue in sequence indicating that it has solved. 

 To view your results, highlight PUMP P-1 and click the View Results button. 
 

 
Pump 'P-1' 
   
 Feeds                                 3 
 Products                             17 
   
                              User Input   Calculated 
                              ----------   ---------- 
 Temperature, F                                 88.15 
 Pressure, PSIG                   550.00       550.00 
 Pressure Rise, PSI                            347.00 
   
 Work, HP                                        2.44 
 Head, FT                                     1293.92 
 Efficiency                        65.00        65.00 

 

 
Figure 7: Pump P-1 Results 
Step 9:  Save and Close the Simulation 
You will use this simulation as a basis for a later example.  

 Select Save on the File menu and save as CHILL1.PRZ.  

 Select Close on the File menu. 
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Chiller Plant Part 2 
Continue to build the chiller plant. Since you already added the UOM, components, and feed stream 
data in that part you won’t need to add these data again.  

The diagram shows the process schematic for this part. The portion of the flowsheet that you entered in 
Part 1 is gray, and the new units and streams you will now add are black. 

 
 
 

  
 
 
 
 
 
 

Figure 1:  
Schematic of Chiller Plant – Part 2 
 

The new equipment data and operating conditions are provided in Table 8. 

Table 8: Equipment Data 
HX-2 Gas to Gas Exchanger Hotside ∆P = 5 psi 

Coldside ∆P = 5 psi 
Approach Temp (Hot In - Cold Out) = 10°F 

HX-3 

 

Chiller Hotside Outlet Temp = -13°F 
Hotside ∆P = 5 psi 
Coldside refrigerant saturated liquid propane at -22°F 

D-3 Cold Separator Adiabatic Separation 

V-1 Valve Outlet Pressure = 245 psig 

 

 Question:  What is the refrigerant flowrate for Heat Exchanger HX-3?          ___________ 
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Chiller Plant Part 3 
Continue to build the chiller plant. Suppose that the refrigerant for the chiller HX-3 consists of a mixture 
rather than pure propane. You want to determine the flowrate of that mixture required to maintain a 
process stream (hotside) outlet temperature of -15ºF. Instead of using the HEAT EXCHANGER refrigerant 
utility in PRO/II, which is designed for use with single components, you now must introduce a 
refrigerant stream, with the correct composition, and use a CONTROLLER to determine the refrigerant 
flowrate. 

The diagram shows part of the process schematic. The portion of the flowsheet that you entered 
previously is gray, and the new units and streams you will now add are black. 

 

 

 Figure 1:  Schematic of Chiller Plant – Part 3 
 

The equipment and refrigerant stream data are shown in Table 9. 
 

Table 9: Refrigerant Stream Data 

Component Mole% 
Ethane 

Propane 

i-Butane 

2.5 

97 

0.5 

Pressure 11.5 psig 

Condition Bubble Point 

 
 Questions: 
 
 1)  What is the refrigerant flowrate (Stream 50) now? 
 
  2)  Why is the flowrate different from the flowrate in part 3? 
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Chiller Plant Part 4 
Continue to build the chiller plant. Add a COLUMN and a COMPRESSOR. Use MIXER units to combine the 
plant liquid streams into one product and the plant vapor streams into another product.  

 

 

 

 

 

 

 

 

Figure 1:  
Schematic of Chiller Plant – Part 4 

 

Table 10: Equipment Data 

Stabilizer Column T-1 
Actual number of trays 
Overall Tray Efficiency 
Feed location 
Top Tray Pressure 
Column ∆P 
Bottom Product TVP 

22 
55% 
Tray 1 
200 psig 
2.5 psi 
235 psig 

Compressor C-2 
Outlet Pressure 
Adiabatic Efficiency 

600 psig 
73% 

 

 
 Questions: 
 
 1)  What is the reboiler duty required to meet the liquid product specification? 
 
  2)  Using “Output/Generate Plot,” plot an overview of the column’s temperatures and flowrates. 
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Two Stage Compressor 
 
A natural gas stream is compressed before entering a pipeline.  The stream is first compressed to 
12 bar and then to 26 bar.  Liquid condenses in the compressor aftercoolers and is recycled back to the 
previous stage.  The liquid product is removed from the feed flash. 
 

  
 
 

 

 

 
 
 
 
 
 
 

 Figure 1:  Two 
Stage Compressor 

Flowsheet. 
 
  

Use the Peng-Robinson Thermodynamic method with the COSTALD correlation for liquid density. 
 

All the data required for this simulation are summarized in the tables below. 
   

 

Feed Stream Data 

Component Flowrate (kmol/hr) Flowrate (lb-mol/hr)

Nitrogen 

Carbon dioxide 

Methane 

Ethane 

Propane 

i-Butane 

n-Butane 

i-Pentane 

n-Pentane 

n-Hexane 

C7 Plus (model as 
NC9) 

180 

1920 

14520 

9070 

7260 

770 

2810 

950 

1630 

1540 

3180 

400 

4230 

32000 

20000 

16000 

1700 

6200 

2100 

3600 

3400 

7000 

Temperature  

Pressure  

40°C 

5 bar 

100°F 

70 psia 

Unit Operating Conditions 

C-1 Outlet Pressure 12 bar 170 psia 

D-1 

C-1

HX-1 

D-2

C-2

HX-2

D-3

S1 
S7 

S2 

S3

S4 S5
S11

S6

S8 S9

S10
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C-1 Adiabatic Efficiency 74% 74% 

C-2 Outlet Pressure 26 bar 380 psia 

C-2 Adiabatic Efficiency 72% 72% 

HX-1 Exit Temperature 60°C 135°F 

HX-1 Pressure Drop 0.35 bar 5 psi 

HX-2 Exit Temperature 60°C 135°F 

HX-2 Pressure Drop 0.35 bar 5 psi 

 
 Answer the following questions: 
 

1. What are the amounts of liquid and vapor leaving the process? 

2. What compressor work is required for each stage? 

3. What are the stream temperatures entering the aftercoolers? 

4. What are the aftercooler duties? 
 

Extra Credit: 
 
Answer the following questions: 
 
1) Can the same information still be obtained with fewer units in the flowsheet?  If so, simulate it and 

check that the data are available and that the values are the same as in the original calculation. 

2) Assuming that you only want to know the product streams from the process, simulate the process 
with the minimum number of units required. 
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Naphtha Assay Part 1 
Enter the assay data for the Naphtha Feed described below and generate a set of petroleum 
components. Also create a plot of the calculated TBP curve and component cuts. The light ends make 
up 5% of the total liquid volume. Use SRK thermodynamics with API liquid density to model the system. 

To represent the boiling curve more closely, increase the number of pseudocomponents by using 
twenty-one 18°F cuts from 80°F to 460°F. The process data is given in Table 6. 

 

Table 11: Naphtha Feed Data 

ASTM D86 Data Light Ends 

LV% °F COMP MOL% 

3 

5 

10 

30 

50 

70 

90 

95 

98 

90 

125 

195 

250 

280 

310 

390 

418 

430 

isobutane 

butane 

isopentane 

pentane 

 

 

Total 

0.70 

2.15 

0.86 

3.58 

 

 

5% Liq. volume 

Average API Gravity 54.2 

Flowrate 1000 lb/hr 

Temperature 100°F  

Pressure 1 atm 

 
Generate the assay processing plot and answer the following question: 
 

1. Where would you want to generate more pseudocomponents? 


